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} Introduction
First of all, congratulations on becoming a Pro Tools user, and welcome (or welcome 
back, if you’re already using Pro Tools and upgrading to Pro Tools 11)! When Avid says 
its powerful digital audio workstation (DAW) is the industry standard, you can believe 
it. You’ll find Pro Tools at all levels of the business, from modest software-only systems 
all the way up to high-end HD/HDX systems, hard at work in every facet of audio and 
musical production. It’s a serious, professional product, and your decision to buy it (and 
learn it well) is a step in the right direction.

The Chinese philosopher Lao-Tsu once said, “A journey of a thousand miles begins with 
a single step.” That’s where this book comes in—it’s that critical first step. Gaining a 
solid fundamental understanding of the basics of Pro Tools will help ensure that your 
journey starts off without a hitch and pointed in the right direction. In this book, you’ll 
learn the basic techniques of composing, recording, editing, and mixing digital audio 
and MIDI (Musical Instrument Digital Interface). You’ll learn how to harness the power 
of Pro Tools’ impressive array of features, from software effects, to virtual instruments, 
to mixes that are automated and edited with some of the best tools you’ll find any-
where.

This is my seventh book about Pro Tools. The first covered version 6 of the software, 
followed with titles on Pro Tools 7, 7.4, 8, 9, and 10. The book you’re holding stands on 
the shoulders of those previous books and includes some of the same material as those 
earlier titles. It also covers exciting new features of Pro Tools 11. Even if you’re a long-
time Pro Tools user, I think you’ll find that the new improvements—things like its 64-bit 
rebuild and offline bounce—represent a new level of flexibility and power. These new 
features, combined with the solid design of Pro Tools in general, make Pro Tools 11 a 
quite exciting release indeed!

If your aim is to create and produce audio, Pro Tools is an excellent choice. Pro Tools 11 
Ignite! will be your companion during those critical first steps on the road of discovery!

Who Should Read This Book?
Essentially, this book is geared toward beginners, and assumes little or no experience in 
working with a DAW. You’ll find that this book’s highly visual and plainly worded style 
makes it easy to follow. Nearly every step in the processes discussed is accompanied by 
clear illustrations, so you won’t have to spend your time hunting around the screen for 
tools and menus. (What fun is that?) Once you’re finished with the chapters and exer-
cises, this book will be a valuable reference later on as well.
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Don’t worry if you’re not a formally trained musician or if you haven’t really 
dealt with digital audio before. The beauty of Pro Tools—and computer music in 
general—is that even untrained (but creative) musicians can enjoy great success in 
this kind of environment. Of course, any general music or audio knowledge you 
bring to the table is an added advantage, but it is certainly not a requirement for 
this book.

With that being said, there’s no denying that Pro Tools is a deep program. Even 
those of us who have been using it for years still find new tidbits now and then. 
For that reason, I can’t dedicate any of the limited space I have in this book to 
covering basic computer operations. That means it’s up to you to understand 
the most basic ins and outs of your particular platform (either Mac or PC). Don’t 
worry too much, though—the general computer knowledge required to use Pro 
Tools is pretty basic. If you can locate, launch, and close programs, you’re prob-
ably in fine shape.

How to Use This Book
At its heart, music (and audio) production is a progressive process. From cre-
ation to performance, it’s the result of many small steps taken in order. A solid 
mastery of Pro Tools works much the same way. This book is laid out to mirror 
the creative process, from setup, through the recording process, editing, mix-
ing, and putting on the final touches. The first sections of the book also include 
a bit of information about the nature of DAWs in general so you understand the 
basic building blocks of digital audio and can work most efficiently. If you’re just 
beginning with DAWs, you’ll find this information valuable in the long run.

Because this book is arranged sequentially according to the production process, 
you’ll be able to follow along from the very start of a project through its comple-
tion. However, if you’re interested in some areas more than others (which is pretty 
common with more experienced users), feel free to take the book out of order 
and just concentrate on those sections first; this book will work that way as well.

You’ll find that most of this book is laid out in a tutorial-style format, with exercise 
files downloadable from the publisher’s companion website, at www.cengageptr.
com/downloads, that you can use side by side with the book’s examples. Of 
course, you can also employ this book as a targeted training source, using the 
clear, illustrated style of this format to your advantage as you locate information 
on specific functions. 

Last but not least, you’ll note that peppered throughout this book are notes, tips, 
and sidebars. Take a look at these to find additional ways to increase your effi-
ciency, additional information on key functions, and even warnings that point out 
common pitfalls and how to avoid them.

INTRODUCTION}
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Finally, a Little Background…
For nearly 30 years, Avid (formerly Digidesign) has been a leader in digital 
audio workstation technology, and the professional community has chosen Pro 
Tools as the clear industry standard. Over the years, many different configura-
tions for Pro Tools have arisen, making choosing a Pro Tools system a bit com-
plex. Never fear, though—these can all be broken down into a couple of simple 
groups. Let’s start out with the software itself:

Q	 Pro Tools HD 11. Short for Pro Tools high definition, this version of Pro Tools has all the 
bells and whistles that Pro Tools can offer. This includes advanced editing and mixing fea-
tures, surround-sound support, and the ability to operate in either a DSP- or Native-based 
environment (I’ll discuss that in just a moment).

Q	 Pro Tools 11. This is your basic Pro Tools system, and although some features present 
in the HD version are missing in the basic version, it is still more than adequate for many 
professionals. It is on this version that this book will focus.

In addition to the software itself, there are two different modes in which Pro Tools 
can operate—either as a hardware-based or host-based DAW:

Q	 Hardware-based (or DSP) systems. These Pro Tools systems rely on dedicated com-
puter cards (called HDX cards) and audio interfaces specifically designed to work with Pro 
Tools. The HDX cards are responsible for Pro Tools 11’s most important functions, including 
input-output management, mixing, and plug-in processing. The audio interfaces used by 
these hardware-based systems are designed to connect directly to the HDX cards. Only 
Pro Tools HD software can operate in a hardware-based mode.

		 Hardware-based Pro Tools systems have specific advantages in the number of inputs and 
outputs (I/O) that the system can manage, the processing power of the system, and over-
all system stability. These systems are commonly found in high-end professional facilities 
that demand the highest standards of scalability and performance.

Q	 Host-based (or Native) systems. When we refer to a DAW as being host-based, we 
mean that the system relies on the computer’s CPU to accomplish all essential Pro Tools 
processes (things like signal management, mixing, plug-in processing, and more). Host-
based systems generally cost less than their hardware-based alternatives, but with the 
ever-increasing power of computer CPUs, are finding a place in more and more profes-
sional facilities. Basic Pro Tools 11 software operates only as a host-based DAW, while Pro 
Tools HD software can operate as either a host-based or hardware-based DAW (depend-
ing on the hardware setup of the system).

		 In terms of audio interfaces, host-based systems will operate with any audio interface that 
has an ASIO or Core Audio driver. Of course, the recommended combination is an Avid 
interface paired with Pro Tools 11, but it is no longer the only choice available to users. 

Speaking of Notes…
Speaking of notes, there’s no time like the present to start! If you already have some experi-
ence with previous versions of Pro Tools, you might be primarily interested in checking out 
what’s new in Pro Tools 11. You’ll find sections (and notes) dedicated to features introduced 
in Pro Tools 11, with titles that call attention to these features.

Q
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The good news—and it’s great news, really—is that regardless of your particular 
Pro Tools configuration, the software environment in which you work is nearly 
identical. That means you can take advantage of one of the most powerful and 
well-developed user interfaces on the market without breaking the bank. What’s 
more, if you’re a Pro Tools 11 user, when it comes time for you to step up to a 
Pro Tools HD or HD|Native system, you’ll be ready to hit the ground running.

Adding to its already impressive arsenal of features, Pro Tools 11 is a highly 
anticipated release, bringing users some very important improvements. These 
include the following:

Q	 64-bit architecture. Typically, when a version of software is updated, new features are 
added to existing computer code. That’s not the case with Pro Tools 11. This is a complete 
64-bit rebuild of the software. As a 64-bit application, Pro Tools 11 can utilize more system 
RAM than could previous 32-bit versions. (32-bit programs can access only up to 4 GB of 
system RAM.) This can radically improve the performance of your Pro Tools system.

Q	 Redesigned audio engine. In line with the overall rebuild of Pro Tools, the previous 
audio engine (called the Digidesign Audio Engine, or DAE) has been replaced with the 
Avid Audio Engine (AAE). This new engine provides for more complex mixes and more 
plug-in power than has been possible in previous versions.

Q	 Offline (faster than real time) “bounce.” In previous versions of Pro Tools, mix-
downs (commonly called “bounces”) needed to be done in real time. In other words, the 
production of a three-minute song included budgeting three minutes in which to create a 
final mix. In Pro Tools 11, you now have the option of bouncing your final mix faster than 
real time (based on the processing power of your computer’s CPU).

If a lot of this sounds like Greek right now, don’t worry—we’ll cover it in the 
chapters to come. Ready? Let’s go!

Setting Up Your Sessions
Throughout Pro Tools 11 Ignite!, you’ll have the option of using session files and 
other downloadable tutorial sessions and audio material so that you can fol-
low along with the specific steps outlined in the chapters. These files will allow 
the tutorial sessions to play in their entirety. Generally speaking, you’ll have no 
trouble downloading these materials to your hard drive.

Pro Tools|HD Native
HD|native is a relatively new mid-range product that brings powerful aspects of both a 
hardware-based and host-based system together. With a single hardware card or thunderbolt 
device paired with HD interfaces, users operate Pro Tools as a host-based DAW, while at the 
same time getting the high fidelity of Avid’s top-of-the-line audio interfaces.

Q
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Go to www.cengageptr.com/downloads. The Cengage Learning online companion 
website will open.

In the Companion Search field, type Pro Tools 11 Ignite, as shown here.

Click on the Search button. The search results will appear.

Click the link for the material you want to download. You’ll be prompted to enter a destina-
tion for your downloaded file, which will vary based upon your platform (Mac or PC) and the 
browser software you are using.

The file that will be downloaded is a ZIP file. You’ll need to extract the contents before 
you can use the session. Again, this can vary depending on your platform.

The folder that will be extracted contains the session and other material for the 
chapter. You’re all set to launch the session! After launching, you may see a Ses-
sion Notes window appear. This may contain a number of messages, including 
the following:
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Click on the book title link 
(in this case, Pro Tools 11 
Ignite). The companion site 
for the book will appear.

In the Companion Contents 
section, click on the link for 
the chapter whose material 
you want to download. You’ll 
be directed to a page dedi-
cated to the materials used in 
that chapter. 

4
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Q	 Some paths were made inactive because they could not be assigned to 
existing path definitions. This indicates that the inputs and outputs of the system 
upon which the session was created don’t match the system with which the session is 
now being launched. Here again, if you can’t hear everything you should, go to the 
I/O Setup window and adjust your input and output paths accordingly (covered in 
Chapter 3, “Getting Started with Audio”).

Q	 In any of these cases, you typically won’t need to see a detailed report, so click on the No 
button.

Your session will continue loading, and in the vast majority of cases, you will be 
ready to go.

If you’ve already read Chapter 1, “Welcome to Pro Tools 11,” you know that 
Pro Tools is a pointer-based application, which basically means that a session 
file—which is really the cornerstone of your project—refers to other files (such as 
audio files) to do its work. To do this, your session needs to know the location of 
the audio files it needs. In rare instances, however, you may see a dialog box 
that states that a number of audio and/or fade files cannot be found. No prob-
lem; you can tell the session where to look for these files.

QQ Q
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Q	 Your I/O setup has 
changed since the last 
time this session was 
saved. Check the I/O 
Setups window to see 
what’s changed. Funda-
mentally, all this message 
is saying is that this session 
was created on a different 
setup from yours.
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Click on the Manually Find 
& Relink option button. 

Click on the OK button. The 
Relink window will appear.
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In the top section of the Relink 
window, click on the hard 
drive in which your ses-
sion and audio files reside. 
Drives and folders that will be 
included in the search pro-
cess will be indicated with a 
checkmark.

In the middle section of the 
Relink window, you’ll see a 
list of filenames in italic print; 
these are your missing files. 
Select them all.

Click on the Find Links 
button at the top of the 
window. The Linking Options 
dialog box will appear.
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Click on the Find By File 
ID option button and the 
Match Format and Match 
Duration checkboxes to 
select them.

Click on the OK button. The 
search for your missing audio 
files will begin.

6

7
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Click on the Commit Links button at the top of the Relink window. 

A final dialog box will appear, asking you if you want to commit links. Click on the Yes button.

That’s it! You can now close the Relink window and continue working. Remember 
to save your session when you’re finished to avoid having to do this a second time!

Q 8
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Q	 When a missing file is 
found, a small icon will ap-
pear next to the appropriate 
filenames, indicating that the 
file has been located by Pro 
Tools. When all files show 
these symbols, you’re ready 
to proceed.

8

9

9

Automatic Find and Relink
In the Missing Files dialog box, you’ll see an Automatically Find & Relink option button. 
It does just what you’d guess: It searches your entire system for missing files. If you aren’t 
sure where your audio files are, this might be a good route to take. But beware: Searching 
through all your attached hard drives might take a long time!

Q

Unique File IDs
Pro Tools assigns a unique file ID to every file it uses, which is its proprietary tag for that file. 
You’ll note that you can choose to find files that match by name, file ID, or both. Although 
it’s quite common to find matching names, those names (including the file extension) must 
match perfectly. Filenames and extensions can vary from platform to platform; for this reason, 
searching by file ID only (as described) is sometimes a good way to make sure your files are 
found in this case.

Q
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}1 Welcome to Pro Tools 11

Congratulations, and welcome to the world of Pro Tools! Throughout Digidesign’s 
and Avid’s nearly 30-year history, Pro Tools has established itself at the forefront 
of the digital audio workstation (DAW) community. Version 11 represents a major 
new release, particularly in terms of system performance and mixing workflows. 

Pro Tools 11 can be found in virtually every facet of the audio industry, from 
music production for CDs to surround sound for movie soundtracks. Now, armed 
with Pro Tools’ powerful array of functions and features, you’ll be able to tap 
into this world of digital audio for yourself to realize your own creative vision. 
Welcome to the party!

The first step in the process is to set up your system and to master the essential 
functions of Pro Tools. In this chapter, you’ll learn how to do the following:

Q	 Identify the hardware and software components of your Pro Tools system and configure 
your audio engine.

Q	 Organize sessions and data in Pro Tools.

Q	 Use Pro Tools’ most basic functions.

Q	 Create, open, play, and close a session.

Q Q Q
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What Makes Up a Pro Tools System?
In the introduction, you learned that there are two different versions of Pro Tools 
software (Pro Tools 11 HD and Pro Tools 11), and two different hardware con-
figurations in which Pro Tools can run (hardware-based or host-based).

For the purposes of this book, I’ll limit this discussions to basic Pro Tools 11 sys-
tems (using Pro Tools 11 software and operating as a host-based DAW), but the 
skills you learn here can be applied to any level of Pro Tools system. 

The Heart of Your DAW: The Computer
Your computer is the cornerstone of your Pro Tools system. The computer, par-
ticularly its central processing unit (CPU), will be called upon to do everything 
from mixing and automation to effects processing and more. That means the 
more power your CPU has, the more powerful your Pro Tools software will be. 
The host computer can be either a PC or a Mac.

In addition to CPU speed, your computer’s random access memory (RAM) plays 
an important role in how your digital audio workstation will perform. It probably 
comes as no surprise to learn that the more RAM your computer has, the better. 
More RAM will enable your Pro Tools session to run more real-time processes 
and will make for an overall more powerful DAW. Avid recommends a minimum 
of 8 GB of RAM to run Pro Tools 11.

Ideally, your DAW computer should be dedicated solely to music- and audio-
related tasks. Other applications running (or even installed) on your system can 
steal from your computer’s overall efficiency when running Pro Tools. Recording 
and playing back digital audio can be demanding on your computer’s CPU, and 
other programs interrupting the steady stream of data to and from your hard 
drive can cause major problems. Of course, having such a dedicated computer 
can be impractical for many users. If you’re not able to devote your computer 
exclusively to Pro Tools, you should avoid running other programs during your 
Pro Tools sessions.

Audio Interface
All DAWs, regardless of brand, require some sort of audio interface to record 
and play back audio (also referred to as input/output, or I/O for short). Inter-
faces can vary from professional-quality devices used at large professional facili-
ties (these facilities often use multiple interfaces together) down to the built-in 
microphone and headphone outputs of a laptop computer. Across this spectrum, 
different manufacturers have created a wide range of products featuring various 
numbers of channels and different levels of audio quality.

Your audio interface is the doorway for audio going to and coming from your 
computer. Generally speaking, your computer will connect directly to the au-
dio interface, and your various audio devices (mixing boards, keyboards, and 
microphones) will connect to the interface’s available audio inputs. To listen to 
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your work, you should connect the main audio outputs of your interface to an 
amplifier, and from there to monitor speakers. If you’re using powered monitors 
(those that have built-in amplifiers), you can connect the outputs of your interface 
directly to the inputs of the speakers.

In past versions of Pro Tools, the Pro Tools software has been unbreakably linked 
to Avid audio interfaces. For example, to run Pro Tools 8 LE, you needed to have 
a connected Avid interface (such as an Mbox), or the Pro Tools software would 
not launch. Possibly the most significant change in Pro Tools 9 was the breaking 
of this dependence on Avid hardware. Pro Tools 11 continues to be independent 
of specific hardware requirements, and is compatible with any interface with 
ASIO (Windows) or Core Audio (Mac) drivers. That means you can use Avid 
interfaces, a third party’s, or even the built-in I/O of your computer.

Hard Drive(s)
Just as traditional tape-based recording studios rely on magnetic tape as a stor-
age medium, Pro Tools relies on hard drives for the recording and playback of 
its digital audio. The drives can be IDE/ATA, SATA, eSATA, FireWire, SSD, or 
USB 2.0.

It is important to remember two factors when choosing a hard drive for Pro 
Tools: size and speed. First, a larger-capacity drive will enable you to store more 
audio data. This will translate into more minutes of audio that you can store, 
higher-resolution digital audio, or both. A fast drive will allow for more efficient 
transfer of data (also called throughput) when you are recording and/or playing 
back audio. This can translate into higher track counts and more reliability when 
working with complex sessions.

Using a Dedicated Audio Hard Drive
Adding a second drive dedicated to the storage of your Pro Tools sessions and 
audio files will greatly increase your Pro Tools system’s performance, whether 
your system is used solely for Pro Tools or is more of a general-purpose machine. 
You’ll still want to install the Pro Tools application on your computer’s system 
drive, but when you create your sessions (something I’ll get into later in this 
chapter), you can put them on your second “audio” drive. That way, you’ll have 
one hard drive occupied with the nominal tasks of your computer and another 
separate drive, with its own read/write head and throughput, dealing only with 
your Pro Tools session and audio.

Partitioning Your Hard Drive
If you’re wondering whether partitioning your system hard drive will do the trick, the short 
answer is no. Partitioning a single hard drive may give the outward appearance of creating 
a second drive, but in reality, there is still only one physical hardware device and only one 
throughput path. Although partitioning can be a convenient way of organizing your data, 
partitioning doesn’t add another physical drive with its own read/write head, so it won’t give 
Pro Tools the same benefit with real-time tasks as a second physical drive would.

Q

Q What Makes Up a Pro Tools System?
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Great Resources: Avid’s Compatibility 
Documents, Knowledge Base, and In-
Application Help
You might have noticed that although I’ve talked about desirable qualities in 
a DAW system, I haven’t mentioned many specific details about what kind of 
hardware you should be using (things such as minimum CPU speed and chip-
set types). I apologize if I seem evasive on the subject, but the truth is that the 
landscape of computer-based products transforms and grows so rapidly that any 
specs I quote here might well be out of date by the time you read this. Don’t de-
spair, though! Avid has provided the help you need to build the Pro Tools system 
you want in the form of an up-to-date list of compatible hardware. You can find 
this list on Avid’s website, at the following URL: http://avid.force.com/pkb/ar-
ticles/faq/compatibility.

To view more technical information and alerts, you can also take a look at the 
Avid Knowledge Base. Although it takes a few steps to get there, it’s well worth 
the trip. On the top of the Avid home page (www.avid.com), click on the Sup-
port and Services link. Then, on the Support and Services page, click on the  
Support Resources tab. On the Support Resources page, click the Find Answers 
link and choose Knowledge Base—Audio from the list that appears. Once you’re 
in the Knowledge Base, you can search in a number of ways, including by prod-
uct or keyword. Whether you’re designing a Pro Tools system or troubleshooting 
one, the Knowledge Base is a trove of technical tidbits!

If that seems like too much work, don’t fret. You don’t even need to leave the 
application! Let’s take a look at two more places you can go to get answers you 
need:
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Q	 The top section of the Help 

menu includes links to online 
support resources, including 
Pro Tools Help, the Knowledge 
Base, and online user forums.
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Q	 The Marketplace drop-down 
menu allows you to quickly ac-
cess your Avid account, go to 
a plug-in purchasing website, 
purchase support, or buy and 
upgrade.

Q

Q
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A Word About Installation
The installation process is basically broken down into two easy steps:

Install the Pro Tools software.

Install the appropriate drivers (ASIO or Core Audio) for the interface(s) that you will use  
with your system. Drivers for Avid interfaces are included with your Pro Tools 11 installation 
materials.

Finding Installation Information
The documentation you received with your Pro Tools software and hardware is 
the first place to look for information on installation. In the ever-changing world 
of computers, though, that documentation could quickly become out of date. 
Once again, the Avid website is an invaluable resource. Just go to the Pro Tools 
Updates page in the Avid Knowledge Base (http://avid.force.com/pkb/articles/
en_US/download/en355241) to see a comprehensive list of all Pro Tools ver-
sions dating back to version 5!

The documentation that came with your Pro Tools product, combined with a little 
Net surfing (if needed), should enable you to successfully install and configure 
your Pro Tools system. Once that’s finished, you’re ready to move on.

Checking for Software Updates
Wouldn’t it be great if there were a way for Pro Tools to help you out with soft-
ware updates? Good news: Pro Tools 11 includes exactly that functionality. It can 
search for any updates, bug fixes, and so on that are relevant to your system. 
Better yet, Pro Tools 11 can also check to see whether there are any updates 

Q A Word About Installation

1

2

Important Operating System Note
Because Pro Tools 11 is a 64-bit application, it can only run on 64-bit operating systems  
(such as Windows 8 or Mac OS X 10.8.4). Pro Tools 11 will not launch on any 32-bit  
operating system.

Q

Can It Be This Easy?!?
In previous versions of Pro Tools, the installation process was, if not onerous, certainly a bit 
time consuming. With Pro Tools 11 on a Mac computer, those headaches are a thing of the 
past. Pro Tools now sports a simple drag-and-drop installation method. Just drag the Pro 
Tools application into the Applications folder, and you’re ready to launch Pro Tools!

Q

Pro Tools 11 and Pro Tools 10 Co-installations
If you’re a Pro Tools user already and aren’t quite ready to let go of your 32-bit plug-ins, 
take heart! Pro Tools 11 and Pro Tools 10 (version 10.3.6 or later) can be installed on the 
same machine. It’s worth mentioning, though, that only one version of Pro Tools can be 
launched at a time.

Q
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Once Pro Tools is launched 
(something I’ll go into later in 
this chapter), click on Help. 
The Help menu will appear.

Choose Check for Up-
dates. The Software Update 
progress window will appear.

needed or available for your installed plug-ins. How cool is that? Pro Tools 11 
even differentiates between paid and non-paid updates, so you can choose to 
make the larger version leaps at your discretion.

Using this new feature is very easy—so easy, in fact, that there’s virtually nothing 
you need to do. By default, Pro Tools will quickly check for updates when you 
launch the program. All you need to do is make sure your computer is connected 
to the Internet, and this will happen automatically. (Don’t worry. This check is 
very quick and doesn’t add too much time to the Pro Tools launch.)

If you want to do an update check manually, you can do that as well. It’s also a 
simple process:

If there are updates to be installed, you will be directed to a website with links for the appro-
priate download(s). If you are up to date, you’ll see the dialog box shown here. Click on the 
OK button to finish the process.

 Q	 If you don’t wish for Pro Tools to perform automatic update searches upon startup in 
the future, just click on the Do Not Check for Updates Automatically checkbox.

iLok Protection
Long-time Pro Tools users should be familiar with the iLok method of copyright 
protection. It’s been widely used for plug-in authorizations by many manufactur-
ers (including Avid). For those who are new to the term iLok, think of it as a key 
that unlocks your software and enables it to run. Starting with Pro Tools 9, all 
versions of Pro Tools now rely upon this method of protection.

1
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Pro Tools 11 requires a second-generation iLok—a hardware device that is rough-
ly the size of a small USB flash drive. It can hold a large number of software 
licenses. In fact, this iLok can store more than 500 licenses. When you purchase 
Pro Tools 11, a second-generation iLok is included in the box. This iLok comes 
pre-loaded with the Pro Tools 11 license, so all you need to do is plug it into an 
available USB port or a USB hub attached to your computer, and you’re ready 
to launch Pro Tools.

Your iLok hardware can be used for more than just your Pro Tools licenses, 
though. If you go to www.ilok.com, you can create an account into which you 
can deposit additional software licenses. With the convenience of the iLok  
copy-protection system, you can even have Pro Tools installed on multiple  
computers (though of course, you’ll only be able to run Pro Tools when the iLok 
is physically attached)!

Choosing an Audio Engine
As discussed, the open design of Pro Tools 11 enables users to employ a wide 
variety of devices for audio I/O—in fact, any audio interface that includes an 
ASIO or Core Audio driver. To make the most of this new feature, though, you’ll 
need to know how to choose the audio engine that works best in any given situa-
tion. To get this fundamental control over Pro Tools, you’ll make use of Pro Tools’ 
Playback Engine dialog box.

Q Choosing an Audio Engine

Q	 A second-generation iLok (left), 
along with an original iLok 
(right). Pro Tools 11 requires a 
second-generation iLok to run.
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Tips on Choosing an Audio Engine
If there’s a downside to this new flexibility, it’s that it’s sometimes hard to make a 
choice! Of course, convenience is a factor. Here are some other things to keep in 
mind:
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Click on Setup. The Setup 
menu opens.

Choose Playback Engine. 
The Playback Engine dialog 
box will appear.

1
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Click on the Playback 
Engine selector. A menu of 
available hardware options 
opens.

Choose the interface that 
you want Pro Tools to use for 
recording and playback of au-
dio. In this image, I’ve chosen 
my trusty Mbox Pro.

Click on the OK button.

3

4

5

12
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 Q	 When it comes to audio quality, one of the biggest factors in terms of clarity and stereo-
imagery width is jitter—the lower the better. Jitter specs for audio gear are often printed 
on product documentation, and are readily available for professional interfaces on the 
Internet. Look for the interface with lowest jitter, and choose that one for your audio inter-
face in the Playback Engine dialog box. If your audio interface’s documentation doesn’t 
include specific information about jitter, it’s a safe bet that an external interface will have 
lower jitter than your computer’s built-in I/O.

Q	 If your computer has built-in sound capabilities (most do), you’ll see some degree of built-
in input or output options listed in the Playback Engine menu. Take care—they mean what 
they say! For example, if you choose Built-In Output, you’ll have no input capabilities in 
your Pro Tools system. If you choose Built-In Input, you’ll have no output! If you want to 
more fully use your Mac computer’s built-in audio hardware, choose Pro Tools Aggregate 
I/O. (I’ll talk more about that a little later in this chapter.)

Q	 If you have a Pro Tools session open and you change your audio engine, Pro Tools will 
automatically save and close your session. Click on the OK button to relaunch the session 
with the new audio engine. If you don’t want to overwrite your session file, choose the 
Save As option before making your audio engine changes. (I’ll talk about the Save As op-
tion at the end of this chapter.)

Setting Up Your Hardware
After you’ve chosen an audio engine, you might want to tweak it a bit, configur-
ing the various options that are included with your audio interface. That’s where 
the Hardware Setup dialog box comes in. It’s the second stage in the process of 
getting your audio hardware properly configured for use with Pro Tools.

Q Choosing an Audio Engine
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Click on Setup. The Setup 
menu will appear.

Choose Hardware. The 
Hardware Setup dialog box 
will appear.

2 1

1

2
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The Hardware Setup dialog box displays information related to the audio engine 
that you chose in the Playback Engine dialog box. If you change audio engines, 
the information displayed in the Hardware Setup dialog box will change ac-
cordingly. There are a few aspects that are commonly seen in this dialog box 
(this example shows the Hardware Setup dialog box that you would see with the 
Mbox Pro):
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Q	 On the lower-left side, you 
can choose a sample rate and 
clock source.

Q	 Depending on the device, 
you’ll see different options in 
the center of the Hardware 
Setup dialog box. In this case, 
you have the ability to con-
figure the Mbox Pro’s Multi-
Button.

Q	 Many interfaces allow fur-
ther customization through a 
dedicated Control Panel. In this 
case, if you click on the Launch 
Control Panel button, you’ll see 
the device’s dedicated mixer.
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Although the appearance of the Control Panel will vary from device to device 
(shown here is the Mbox Pro Control Panel), it is here that you’ll gain a deeper 
level of control over your audio interface.

The Pro Tools Aggregate I/O
For the most part, Pro Tools is identical whether you’re using a PC or a Mac. 
However, there is an interesting feature that is currently available only on Mac 
computers: the Pro Tools Aggregate I/O. Using the Aggregate I/O, you can 
simultaneously use multiple interfaces. For example, you can use an external au-
dio interface, plus your computer’s built-in inputs and outputs. Let’s take a look:

Click on Setup. The Setup menu will appear.

Choose Playback Engine. The Playback Engine dialog box will appear.

Now, let’s go back to the Hardware Setup dialog box:

Click on Setup. The Setup menu will appear.

Choose Hardware. The Hardware Setup dialog box will appear.

Q Choosing an Audio Engine
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Click on Playback Engine. 
A menu of available hardware 
options will appear.

Choose Pro Tools 
Aggregate I/O.

Click on the OK button to 
close the Playback Engine 
dialog box.

3
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5

1

2

3 4 5

3

Click on the Launch Setup 
App button. The Audio 
Devices dialog box of the  
Mac Audio MIDI setup dialog 
box will appear.
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The Audio Devices dialog box lists not only individual audio devices that are 
attached (or built in) to your computer, but also a collection (or aggregate) of 
devices that can be used collectively. There are a few essential elements of this 
dialog box that will help you get the most out of your system:

Q	 To add or remove devices from your aggregate, click on the checkboxes in the Use 
column. As you might expect, checked boxes indicate that the device is an active part 
of the aggregate. (Once again, please remember that the Pro Tools Aggregate I/O was 
designed with only your built-in I/O in mind.)

Q	 Individual devices often include some level of configurability—things like volume control, 
audio source, and so on. Click on the device you want to tweak, and you’ll see the setup 
options in the right section of the Audio Devices dialog box. (You can select a device 
either within the aggregate list or outside the aggregate.)

Disclaimer
The Aggregate I/O opens up a huge variety of configurations, and there isn’t enough time or 
resources for Avid to test and qualify every possible permutation of devices. With that in mind, 
it’s worth noting that Avid officially supports only the aggregation of a Mac’s built-in I/O.

Q

Av
id

®
, A

ll 
Ri

gh
ts

 R
es

er
ve

d.

Q	 To reveal a list of all the devices 
included in the Pro Tools Aggre-
gate I/O, click on the triangle 
icon to the left of the Aggregate 
icon.

Q	 Click on the Pro Tools Aggre-
gate I/O menu item to manage 
the aggregate devices. (These 
devices appear in the right sec-
tion of the Audio Devices dialog 
box, as shown here.)

Q	 The first thing you’ll want to do 
is to choose a clock source for 
your aggregate devices. Be-
cause the Pro Tools Aggregate 
is intended for use with your 
Mac’s built-in I/O, Avid recom-
mends using the default clock 
settings.

Q Q Q QQ
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Understanding Sessions and Files
Now you’ve gotten Pro Tools installed, and your system is set up (at least from 
a hardware perspective). Before you get any deeper into the world of Pro 
Tools, you should take a moment to understand the general principles behind 
this powerful digital audio workstation. An understanding of Pro Tools’ overall 
architecture and how different elements work together is important fundamental 
knowledge as you continue to grow as a Pro Tools user.

Pro Tools Is a Pointer-Based Application
It’s common to refer to a cursor as a pointer. But when discussing a pointer-based 
application like Pro Tools, we’re referring to the way the program deals with 
digital audio data. In Pro Tools’ case, this pointer-based structure can be broken 
down to three basic interdependent elements: session files, folders, and audio 
files. In this context, the term pointer refers to the way your Pro Tools session file 
will access (or point to) other files on your hard drive as your session plays.

A session folder is created when you create a new session. It contains the follow-
ing items (as needed):

Q	 Session file. The session file, which bears the project’s name and has a file 
extension of .ptx, is at the top of the Pro Tools hierarchy. This is the file created by  
Pro Tools when you create a new session, and it’s the file you open to return to a 
session you’ve already created. Although this file is relatively small, it is the master of 
all your session elements. Session files have a .ptx extension and contain the following 
session elements:

Q	 The names, types, and arrangement of all tracks in your session

Q	 All MIDI data

Q	 Essential settings, such as inputs and outputs

Q	 All edits, fades, and automation data

Q Understanding Sessions and Files
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Maximum I/O
When dealing with multiple interfaces, you can really start adding up channels of I/O. But is 
there any limitation? Actually, yes. With Pro Tools 11 (the basic standalone software version), 
you’ll have up to 32 channels of inputs and outputs. That’s often just fine for smaller facilities, 
but if you need more, consider Pro Tools|HD Native, which supports up to 64 channels of 
I/O, or Pro Tools|HDX, which maxes out at a whopping 192 channels of I/O!

Q

Drift
The Drift checkbox allows you to enable individual members of the Pro Tools Aggregate I/O 
that aren’t connected via word clock connections to resample their outputs as needed. As a 
general rule, click the checkbox for any non–word clock devices except the device chosen as 
a clock source.

Q
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Q	 Audio Files folder. As soon as audio is recorded, it’s stored in an Audio Files folder 
within the session folder. Different takes are stored in this folder as individual audio files. 
When you play a session, Pro Tools accesses, or points to, the audio files in this folder.

There are additional folders that can be created by Pro Tools as needed:

Q	 Clip Groups folder. Pro Tools enables you to select multiple clips (something I’ll talk 
about later in this chapter) and link them together in a single clip group. Digital audio, 
MIDI, and video clips can be grouped together, making editing much faster and easier. 
You’ll learn more about clip groups later; for now, just know that groups you create are 
stored in this folder. (If you don’t create any clip groups in a given session, a folder won’t 
be created.)

Q	 Rendered Files folder. Pro Tools 7.4 introduced a great feature called Elastic Audio. 
This was a very cool addition indeed, and one you’ll learn about in Chapter 10, “Moving 
to the Next Level: Tips and Tricks.” For now, all you need to know is that when you work 
with Elastic Audio, you have the option of rendering your elasticized audio to an audio 
file—and when you do, it will be stored in this folder.

Q	 Session File Backups folder. Depending on your preference settings, Pro Tools can 
automatically create backups of your sessions and store them in this folder. By default, a 
new session backup is created every five minutes, and the folder keeps the last 10 backup 
files. This is highly recommended, particularly for new Pro Tools users; it can help you 
recover quickly if you encounter technical trouble.

Q	 Plug-in Settings folder. In Pro Tools, you have the option of using plug-ins, which 
are programs designed to work within the Pro Tools environment and function as virtual 
effects. (You’ll learn more about plug-ins in Chapter 8, “Basic Mixing.”) When you create 
specific plug-in presets, you have the option of saving them in this session subfolder.

Q	 Video Files folder. When your session calls for a video track, you can save it in this 
session subfolder.

Sessions and Audio
It might appear as if the only thing you need is a session file, but that’s usually not the case. 
Although session files contain all the important aspects of a project, they don’t actually 
contain any audio. Instead, a session file refers (or points) to audio files located in dedicated 
folders within your session folder.

Q

How Do Audio Files Get Their Names?
When you record audio in Pro Tools, the name of the file you create follows the name of the 
track on which it was recorded. For example, if you record onto a mono (one-channel) Audio 
track named Bass, the files created by Pro Tools in the Audio Files folder will be named 
Bass_01, Bass_02, and so on as you record takes on this track. In the case of stereo Audio 
tracks, two mono files (one for the left side and one for the right) are usually created. For ex-
ample, if you record onto a stereo Audio track named Drums, two files, named Drums_01.L 
and Drums_01.R, will typically be created.

Q
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Clips Versus Files
Given the fact that Pro Tools records audio to individual files on your hard drive, 
how do you later access these files? Simply put, when audio is recorded to an 
Audio track (or even MIDI data to a MIDI track), Pro Tools creates an object 
called a clip in the Edit window. In the case of Audio tracks, these clips refer (or 
point) to files on your hard drive, triggering them to sound as your session plays.

Here’s a close-up of the Pro Tools Edit window. There are three Audio tracks in 
this session (Vocal 1, Vocal 2, and Vocal 3), and a single clip on the Vocal 2 
track.

Working with clips has many advantages. One of the first you’ll discover is that 
you have the ability to move them earlier or later on the session’s timeline, en-
abling you to position the clips precisely in time. An environment like this, in which 
you have the ability to manipulate elements independently on the timeline, is com-
monly described as nonlinear. In addition to moving clips earlier or later in time, 
you have the option of moving them to other similar tracks. (In other words, you 
can move a clip on a mono Audio track to another mono Audio track, and so on.)

Q Understanding Sessions and Files

What About the WaveCache?
There’s one more file you’ll often find in your session folder that I  haven’t talked about yet. 
It’s a small file named WaveCache.wfm, and it stores all the waveform overviews for any 
audio in your session. Waveform overview is a fancy way of describing the visual represen-
tation of audio waves that you might see on an Audio track. This small file is automatically 
created and updated, so there’s nothing you need to worry about with it!

Q
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Nondestructive Editing
Another great advantage of pointer-based editing is that you can nondestructive-
ly trim or split the clip—meaning no audio data is lost, so you can always undo 
what you’ve done. This can be a tricky concept, so let’s take a look.

In this example, let’s assume that the clip named Vocal Comp is playing an  
audio file of the same name in the Audio Files subfolder. What if you don’t want 
to use the whole file in your session? No problem! You can just adjust the start 
or end point of that clip, effectively taking the unwanted bits of audio out of your 
session.

Does this mean you’ve changed the file on your hard drive? No! You’ve only 
changed the clip that is pointing to that file, so only a portion of that file will 
be heard in the session. Don’t worry; because you haven’t changed the audio 
file (only the clip that is pointing to it), you can always drag the clip boundaries 
back out if you change your mind later!

In addition to being able to trim data, there are other situations in which nonde-
structive editing can aid you in your production work, and you’ll discover them 
as this book proceeds. The bottom line is that a nonlinear, pointer-based environ-
ment coupled with nondestructive recording and editing gives an educated Pro 
Tools user a huge amount of flexibility and power, and the ability to undo chang-
es and operations when needed.

Basic Pro Tools Operation
It’s the end of the beginning. You’ve set up your system efficiently, taken some 
time to understand the way Pro Tools works, and now, based on that understand-
ing, you’re ready to start working. 

The Quick Start Dialog Box
The Quick Start dialog box will appear when you launch Pro Tools and will 
give you a number of useful options for creating or opening a session. Let’s run 
through them one by one.

To create a session by choosing a template, follow these steps:

Av
id

®
, A

ll 
Ri

gh
ts

 R
es

er
ve

d.



Q Q Q

17

Click on the Template Category menu to reveal a list of categories. (Note that you can 
organize your template list into different categories. You’ll learn how later in this chapter.)

Choose a category. The list below the menu will be populated by the templates in that 
category. 

Click on the template you want to load. 

Q	 Click the Session Parameters triangle to reveal details about the session you’re about 
to create. If you want to change any aspect of the session, such as the sample rate or 
bit depth (aspects I’ll talk about later in this chapter), you can do it here.

Click on the OK button to create the session. (Clicking on the Cancel button will bypass the 
Quick Start dialog box.)

Q Basic Pro Tools Operation
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Click on the Pro Tools 
program icon to launch the 
Pro Tools application.

Click on the Create 
Session from Template 
option button in the Quick 
Start dialog box. A list of tem-
plate categories and template 
files will appear to the right of 
the option button cluster. 

1

2

What’s a Template?
What’s a template? I’ll get into that later in this chapter and book. For now, just know that 
opening a template session will create a new session, complete with basic tracks, plug-ins, 
and so on, so that you can get straight to work.

Q

3

4

5

Q 5 32 4
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6
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Alternatively, you can create or open a session by performing one of the follow-
ing actions in the Quick Start dialog box:

Q	 Click on the Open Session option button, then click on the OK button to launch a standard 
File Open dialog box. This is the same dialog box you can access from the File menu in 
Pro Tools, which I’ll go through in the next section.

Opening a Session When Pro Tools Is Running
Suppose Pro Tools is already running, and you’ve already gone past the Quick 
Start dialog box. Here’s how to open a session:

Bypassing the Quick Start Dialog Box
If you don’t want to see the Quick Start dialog box when you start Pro Tools (in which case 
you’d go directly to Pro Tools with no session loaded), just click on the Show Quick Start 
Dialog When Pro Tools Starts checkbox to remove the checkmark (this box is checked by 
default), then click on the OK button.
You can also prevent the Quick Start dialog box from being displayed when Pro Tools  
starts using the Preferences dialog box (which you’ll learn quite a bit about as this book  
progresses). To do so, open the Pro Tools Setup menu and choose Preferences. The Prefer-
ences dialog box will open; click on the Show Quick Start Dialog When Pro Tools Starts 
checkbox in the lower-right corner of the Display tab to remove the checkmark. Then click  
on the OK button.

Q

The Chapter 1 Exercise Session
At this stage, you might not have a pre-existing Pro Tools session to work with. No problem. 
Included with the online support materials for this book is a number of exercise sessions for 
you to practice with. You can download these sessions from www.cengageptr.com/downloads. 
For information on downloading this book’s exercise materials, please refer to the “Setting Up 
Your Session” section of the introduction.
The session that this chapter will use is a little piece called “Listen”—the exercise session is 
named “Chapter 01 Exercise Session (Listen).” I originally composed and produced this for 
an audio/video tradeshow in Japan, with the help of Avid Technology’s own Tsukasa Toki-
wano and Kazumi Mihashi. Also, special thanks go to my dear daughter, Sachiko Hagerman, 
for helping me with the Japanese! Note that the exercise materials are for educational use 
only, and not to be used for any commercial purposes.

Q
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Q	 Click on the Create Blank Ses-
sion option button to create 
a session from scratch. I’ll go 
through the details of creat-
ing a new session later in this 
chapter. Then click on the OK 
button.

Q	 Click on the Open Recent 
Session option button to 
choose from a list of your most 
recently opened sessions (the 
list will appear to the right of 
the option buttons). Then click 
on the OK button.
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Using the navigation conventions of your computer’s operating system, select the drive, 
folder, and subfolder (if necessary) in which your session folder resides. Remember that 
the session folder is named after the name of the session, so if you’re using the tutorial  
material, the folder you’re looking for is named “Chapter 01 Exercise Session (Listen).”

Once the session folder is created, open the folder to display its contents.

Q Basic Pro Tools Operation
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Click on File. The File menu 
will appear.

Click on Open Session. 
A standard File Open dialog 
box will appear.

1

2

1 2

Your First Shortcut
Pro Tools includes shortcut keys that enable you to work more efficiently. The shortcut for 
Open Session (Command+O on a Mac and Ctrl+O in Windows) is very useful—and easy to 
remember as well!

Q

3

4
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Opening a Session When Pro Tools Is Not Yet Launched
In this case, suppose Pro Tools is not yet launched. To open a session, follow 
these steps:

Using the navigation conventions of your computer’s operating system, select the drive, 
folder, and subfolder (if necessary) in which your session folder resides. Remember that 
the session folder is named after the name of the session, so if you’re using the tutorial mate-
rial, the folder you’re looking for is named “Chapter 01 Exercise Session (Listen).”

Open the folder that contains the session file. The contents of the folder will be displayed.

Double-click on the desired session file. Pro Tools will launch automatically, and the ses-
sion will be loaded.

Creating a New Session
Now let’s take a closer look at the important process of creating a blank new 
session. (Many of these topics also apply to opening template sessions.) Once 
you’ve gotten your system together and everything working, your next step may 
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Click on the desired session 
file. The file will be selected.

Click on the Open button. 
The session will be loaded into 
Pro Tools.

5

6

Open Recent Sessions
The ability to select a recently opened file from a list is fairly common in the software world, 
and most users will be familiar with this idea from other applications. You’ve already seen the 
Open Recent Session option in the Quick Start dialog box, but you also have this available in 
Pro Tools itself. The Open Recent command can be found immediately below the Open Ses-
sion command in the File menu. Simply click on Open Recent, and you will see a list of up to 
10 of your most recently opened sessions.

Q

1

2

3

5 6
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be to create a new session (as opposed to opening a pre-existing session, as 
you did in the previous section of this chapter). The earlier discussion of how Pro 
Tools works will come in handy here.

Starting the Process
Earlier, you learned that you can create a blank new session from the Quick Start 
dialog box, but you can also create a new session from within Pro Tools itself. 

With Pro Tools running, click on the File menu.

Click on New Session. The New Session dialog box will open. In a sense, it is a smaller 
version of the Quick Start dialog box.

Choosing Session Parameters
Whether you’re creating a new session from the Quick Start dialog box or from 
the File menu, your next task is to choose your session parameters.

Q Creating a New Session

1

2

More Shortcuts!
As you explore Pro Tools further, you’ll notice that many functions have shortcut keys associ-
ated with them. These shortcut key combinations are often displayed to the right of their func-
tions, such as the shortcut for creating a new session—Command +N (Mac) or Ctrl+N (PC). 
Although there are far too many shortcuts to learn them all at once, learning the combina-
tions for popular functions, such as opening or creating a session, can help you work more 
efficiently.
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Click on the Create 
Session from Template 
option button to gain 
access to your session tem-
plates, just as you did in the 
Quick Start dialog box. 

OR

Click on the Create Blank 
Session option button to 
create a new session, just as 
you can do in the Quick Start 
dialog box. For now, select 
this button.

3a

3b

3a 3b
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Q	 BWF (.WAV). A WAV file is a Windows standard file, and the Broadcast Wave Format 
(BWF) is a version of this file type that is particularly suited to television and film produc-
tion. (The file extension is still .wav.) This is a good format choice for session files that will 
be used in both Mac and Windows systems.

Q	 AIFF. This was originally the standard file format for Mac computers.

Click on the Sample Rate selector. A menu will appear, showing the sample rates sup-
ported by your audio interface. 

Select a sample rate for your session.

Select 16 Bit, 24 Bit, or 32 Bit Float as the bit depth for your session.

Choosing a File Format
Pro Tools’ default file format is BWF (.WAV). This generally works well in most situations. If 
you are planning to share files between Mac and Windows systems, this is the preferred file 
format. There is no difference in audio quality between BWF (.WAV) and AIFF.

Q

5

4

3

32 Bit Float Audio
For some, the idea of 32-bit floating-point audio is something new, as it is virtually unused 
outside of DAW production environments. Very simply put, using 32-bit floating-point audio 
will give you a larger dynamic (volume) range, which can greatly simplify the mixing process 
(especially in complex sessions using plug-in effects). On the other hand, 32-bit audio will re-
quire more hard-disk storage space and processing power, and using 32-bit audio may result 
in lower track counts (especially if you’re using a slow hard drive).

Q
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1 35

Click on the Audio File 
Type selector. A menu will 
appear.

Choose a file type from the 
following options:

1

2

Support for Interleaved Files
An interleaved audio file is a single file that has multiple channels (e.g., stereo) combined 
into a single file. A good example of this would be the tracks on an audio CD. If you look 
at the files, there’s only one per track, although you’ll hear a stereo output. That’s because 
they’re interleaved.

Q
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If you don’t choose to use interleaved files, then any interleaved files that are im-
ported (audio CD track files, for example) will be split into individual mono files. 
(In the case of an audio CD track, it would be split into a left channel file and a 
right channel file.) 

You’ve made some very important choices. The next step is to choose a name and location 
for your session. Click on the OK button to proceed. The Save dialog box will appear, and 
you’re ready to move on.

Q Creating a New Session
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Q	 To set up your session to use 
interleaved audio files, select 
the Interleaved checkbox.

Click on the I/O Settings 
selector. The I/O Settings 
menu will appear.

Select your I/O (Input/
Output) settings for this 
session. For now, choose 
Stereo Mix. The option will be 
selected.
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6

7

Where Can I Learn More About I/O Settings?
Your I/O settings determine the assignments and names of inputs, outputs, inserts, and buses. 
Don’t worry if this doesn’t make a lot of sense now; you’ll learn more about how to make the 
most of your I/O settings in Chapter 3, “Getting Started with Audio.”

Q

6 7

Q

8
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Choosing the Name and Place
Two of the most important skills you can learn as a DAW user are file manage-
ment and documentation. Although these are fairly simple and straightforward 
tasks, you shouldn’t underestimate their importance. The last thing you want is to 
misplace a session and waste valuable time trying to find it—or worse, inadver-
tently delete a session because it was in the wrong place!

If you followed the steps in the previous section, you should now be seeing a Save dialog 
box. The next thing you have to do is to choose the name of your session. Type a descriptive 
name in the Save As text box in the Save dialog box.

Navigate to the desired drive. If you have a hard drive devoted to digital audio, choose 
that drive. In some cases, you might also want to create a new folder in which to put your ses-
sion folder—for example, when grouping sessions of a similar genre or artist. If you do, create 
a new folder according to the normal conventions of your operating system. Remember, Pro 
Tools will automatically create a session folder as well!

Once you’ve set your name and location, click on the Save button. Your session will be cre-
ated and loaded into Pro Tools. Good job!

Playing a Session
Let’s assume you have Pro Tools running and you’ve opened a pre-existing 
session (for example, the Chapter 01 Exercise Session you may have opened 
earlier). Wondering how to play it? No problem—it’s easy!

You’ll find a transport section in the top area of the Edit window (which you’ll 
learn more about in the next chapters). It will help you with basic play and 
record operations. It looks very much like the controls you would find on almost 
any media player. Let’s take a look at the basic functions:

3

2

1

How to Get to the Edit Window and Transport Controls
If you’re not seeing any transport-style controls at the top of your Pro Tools window, you’ve 
probably opened your session into the other main window (called the Mix window, which 
looks very much like a mixing console). Getting to the Edit window is very easy: Just open the 
Window menu at the top of the Pro Tools window and choose Edit.

Q
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 Q	 The Stop button—you guessed it—stops playback.

Q	 The Play button plays back your session from the current position.

Q	 The Return to Zero button takes you directly to the beginning of your session.

Q	 Rewind quickly moves your playback point earlier in your session.

Q	 Fast Forward quickly moves your playback point later in your session.

Q	 The Go to End button takes you directly to the end of your session.

Saving Your Work
Now that you have the basics down, it’s time to think about how to wind things 
up. This is a crucial stage, and it’s important to do the job correctly. There are a 
number of ways to save your work, each with its own specific advantages.

Q Saving Your Work

Q
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Q	 If you are in the Edit window 
and you are still not seeing any 
transport controls, click on the 
small triangular button in the 
upper-right corner of the Edit 
window and choose Transport 
from the list that appears. (This 
is a section of the Edit window 
that I’ll go into in greater detail 
in Chapter 2, “Getting Around 
in Pro Tools.”)

Stop Play

Return  
to Zero

Rewind Fast  
Forward

Go to 
End
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Save and Save As
Saving a session is about as straightforward as they come:

If you use the Save command, the previous version of the session will be over-
written with the one that you just saved. What if you don’t want to overwrite the 
old session? That’s where Save As comes into play.

1 2 3 4
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Click on File. The File menu 
will appear.

Click on Save As. The Save 
Session As dialog box will 
open.

Type a different name for 
your session in the Save As 
text box to avoid overwriting 
the original session.

Click on Save. The new 
version of the session will be 
saved with the name you spec-
ified in step 3. You are all set 
at this point to continue work 
on the newly saved session.

1

2

3

4
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Click on File. The File menu 
will appear.

Click on Save. Your work 
will be saved, and you can 
continue to work on the saved 
session.

1

2

1 2
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Save Copy In
If you want to save your session with a different name and create a new folder, 
complete with all the dependent audio files, the Save Copy In feature is for you! 
This is commonly a part of the final archiving process when a project is complete 
(which you’ll learn more about later).

Q	 Session Format. This menu contains options for previous versions of Pro Tools. Select 
one of these formats if you intend to open this session in an older version of Pro Tools.

Q	 Session Parameters. These are the same options you saw when you created your ses-
sion. You can select different file types, sample rates, and/or bit depths for your session. 
Pro Tools will automatically convert audio files as needed in your new session’s Audio Files 
folder.

Q	 Items to Copy. You can choose the elements of your original session that you want 
to copy over to your new session folder. Click on the appropriate checkboxes to copy 
aspects of your old session to your new session folder.

Q Saving Your Work
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Where Do I Save the New Session File?
It’s important to note that both the original session file and the new version of the file can 
reside in the same session folder and can access the same source audio files. You just need to 
make sure they don’t have the same name.

Q

1 2 Q QQ
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Click on File. The File menu 
will appear.

Click on Save Copy In. The 
Save Session Copy dialog box 
will open. Save Copy In en-
ables you to save elements of 
your session (audio files, fade 
files, and so on), which gives 
you a whole new dimension 
of flexibility. Here are some 
things you can specify:

1

2
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When you’ve made the appro-
priate selections, click on the 
OK button. The Save dialog 
box will appear.

In the Save As text box, type 
a descriptive session name 
that is different from the origi-
nal session name.

Select a location for your 
session. This section is identi-
cal to the related sections in 
the dialog boxes when you 
choose Save or Save As. This 
time, a new folder will be 
created for your new session, 
though.

Click on the Save button.

Exporting Selected Tracks as a New Session
What if you want to create a new session, but you want that session to include 
only some of the tracks in your original session? Don’t worry—Pro Tools has you 
covered! This is a variation on what you just learned about Save Copy In:

3
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The Importance of Backing Up Your Work!
Backing up (or archiving) your work is a tremendously important part of production. It might 
not be terribly exciting, but you’ll be glad you established good file-saving habits when 
something unexpected happens. The Save Copy In feature is particularly suited to archiving 
because it makes copies of your original session in a separate (and hopefully safe) place. Ad-
ditionally, this process can intelligently gather all the elements your session needs (assuming 
you selected them in the Items to Copy section) and save them in one central location. Bottom 
line: When you’re backing up your session, Save Copy In is a very smart way to go!

Q

Preserve Folder Hierarchy
Sometimes, particularly in sessions with higher track counts, you’ll need to utilize multiple 
audio hard drives for your session for reliable playback (something I’ll discuss in Chapter 4, 
“Recording Audio,” and in Chapter 10, “Moving to the Next Level: Tips and Tricks”). Check-
ing the Preserve Folder Hierarchy checkbox will archive your session with individual audio 
file folders for each hard drive within your saved copy session folder. This makes it much 
easier to reconstruct large sessions spanning multiple drives!

Q
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Q Saving Your Work
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Choose the tracks in your 
session you want to export. 
The horizontal rows in the 
Edit window are called tracks 
(which you’ll learn more 
about in later chapters). You 
can select the tracks that you 
want to export by clicking on 
the track name. To select a 
range of tracks, hold down the 
Shift key as you click on the 
first and then the last track in 
the range. To select multiple 
tracks that aren’t part of a 
range, hold down the Com-
mand (Mac) or Ctrl (PC) key 
and click on each track you 
want to select. In this image, 
I’ve chosen the Groove Pad 
Stem, Groove Bass Stem, and 
Groove Drums Stem Audio 
tracks.

Click on File. The File menu 
will appear.

Click on Export. The Export 
submenu will appear.

Click on Selected Tracks 
as New Session. 

1
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The Save Session Copy dialog box will open, which you already worked with 
earlier in this chapter. Note that the Selected Tracks Only box is checked (in the 
lower-left corner). Once you choose your Session Parameters and Items to Copy 
settings, a session copy will be created, but the copy will include only the tracks 
that you specified in step 1.

Session Templates
As you saw in the Quick Start dialog box, you already have a list of useful 
templates that are installed with Pro Tools, but you also have the ability to create 
templates of your own. It’s easy!

Choose the Select Location for Template option button to be able to choose any 
name and location for your template file after you click on the OK button. This is particularly 
handy for Pro Tools users who work in multiple studios. (An inexpensive USB drive can hold 
many session templates, and you can carry it with you easily.)

Before clicking the OK button and creating a template, let’s assume that you 
want to create this template on your system, and that you’ve chosen the Install 
Template in System option button. Let’s take a look at the different options open 
to you:

21 3a 3b
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Click on File. The File menu 
will appear.

Click on Save As Tem-
plate. The Save Session Tem-
plate dialog box will open. 
You have two options as far 
as location is concerned:

Choose the Install 
Template in System 
option button to automati-
cally create your template in 
the default system location. 
This will enable you to easily 
access the template from the 
Quick Start dialog box in the 
future.

1

2

3a

3b
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Q	 The top section of the list shows you pre-existing categories, into which you can place 
your template. Just click on the desired category to choose it.

Q	 The Add Category menu item enables you to create a new category and add it to the 
list shown in the top section. Click on this option, and you will be prompted to name 
your new category.

Q	 The Reveal Session Templates Folder menu item will open the template folder us-
ing your computer’s file browser (Finder or Windows Explorer, depending on your 
platform). This is useful for managing your template files (renaming, deleting, and so 
on). It’s worth mentioning at this point that Pro Tools template files are not session files 
themselves, and that they have a .ptt file extension.

When you’re finished, click on the OK button to create your template.

Q Saving Your Work
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1 Click on the Category 
selector. A list of category 
options will appear.
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After you’ve chosen the ap-
propriate category, type a 
name for your template in the 
Name text box. (Clicking on 
the arrow button to the right 
of the field will display a list of 
all the templates currently in 
that category.)

In most cases, you won’t want 
your template to include any 
audio or video files. But if 
you do, select the Include 
Media checkbox.

2

3

4
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Closing Your Session and Finishing Up
The last basic procedure you have to master is to close down your session.

Click on File. The File menu will appear.

Click on Close Session. Pro Tools will shut down the current session and make itself ready 
for the next step (either quitting Pro Tools or opening another session).

Quitting the Pro Tools application follows the normal conventions of your computer for closing 
applications.

That’s it—good job!

Do You Want to Save Your Changes?
Before your session closes completely, a message box might prompt you to save your 
changes. This message box appears when you make any changes to your session and then 
try to quit Pro Tools before saving those changes. You can choose Save or Don’t Save and 
move on.

Q
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